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Welcome to  KQED and  
Dig i ta l  Storyte l l ing!

This manual for beginning digital storytellers contains
KQED’s approach to digital storytelling plus tips and
techniques to help you achieve impressive results in
your productions. 

A digital story is an engaging and creative multimedia
production in which people or organizations document,
preserve and share memorable stories of their lives or
significant experiences of a group that are worth
repeating. The multilayered process results in a 
tangible, valuable and lasting record of powerful 
experiences to save and share. 

We hope you find this manual useful, and consult it
often throughout your digital storytelling workshop 
and beyond. 

Leslie Rule
KQED Digital Storytelling

This manual is made possible by the generous 
support of Adobe Youth Voices.
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Digital storytelling has been practiced since the early 1990s when 
consumer-level technology, including personal computers, video 
cameras and scanners, proliferated to make home video production 
possible. This was a monumental shift in a creative field previously 
available only to professional video producers at facilities with 
expensive equipment and specially trained technical staff to run 
everything. The technical process was complicated in the early 
years of digital storytelling, and completing a story often required 
a significant amount of technical (hardware and software) support. 
A nontechnically inclined storyteller was frequently frustrated, 
struggling with complex equipment that hampered his/her creative 
ability to put images to the words in mind.

Thanks to ongoing research, technology continues to evolve, 
become more simplified and attainable. Today, the tools and 
process of digital storytelling have been so streamlined that 
even first-time computer users can achieve excellent results!

From a broad perspective, digital storytelling can encompass 
many forms of creative expression. However, as an accepted 
definition, digital storytelling is the modern manifestation of the 
ancient art of storytelling. Throughout history, storytelling has 
been used to share knowledge, wisdom and values. Digital 
storytelling uses digital media to create visual stories to show, 
share and, in the process, preserve as history. Digital stories 
derive their impact by weaving together images, music, narrative 
and voice to give depth and dimension to the narrative. By using 
the Internet and other forms of digital distribution, digital stories 
can be seen across distances and boundaries to create new 
communities through a sense of shared meaning.

What is digital storytelling?



The KQED Education Network’s Digital Storytelling Initiative offers hands-on
digital storytelling workshops that teach the principles of multimedia through
storytelling. Two-, five- and 10-day workshops are available for teachers, 
students, community activists and any interested organization. Our participants
learn by doing, and they get to create their own stories in an encouraging, fun
environment. The goal of these workshops is to provide everyone involved with
the intellectual, technical and creative skills necessary to independently create
digital stories about their work, school or personal endeavors. The KQED Digital
Storytelling Initiative (DSI) comes equipped with a state-of-the-art portable
computer lab. Hardware and software configurations are customizable for indi-
vidual groups or classes.

The DSI workshop process is based on these simple stages:

F I N D I N G  T H E  E X P E R I E N C E  
Story exploration and discovery exercises help participants identify potential
story ideas, then narrow them down to a specific focus. Thus, the story 
narrative begins.

T E L L I N G  T H E  S T O R Y
Workshop participants are taught how to verbalize and visualize their 
story through scripting and storyboarding. After identifying and collecting 
supporting audio/visual materials, they digitally prepare all the pieces for 
the editing process. 

C R E AT I N G  T H E  P I E C E
Students create first versions of their story using video and audio editing 
software. Revisions are made and enhancements, including titles, credits,
graphics, video transitions and sound effects, are added for polish and impact. 

P U B L I S H I N G  T H E  W O R K
With their movies completed, students now learn how to export their story for
play on different media and platforms, such as CD, DVD, VHS tape and the
Web. Students also touch on the bigger picture, discussing how the digital 
storytelling process and curriculum could be used as an agent for change in
communities or organizations they care about. 

Each of these KQED Digital Storytelling stages and the corresponding technolo-
gy will be examined in closer detail in the chapters that follow.

The KQED Digital Storytelling Initiative: 
Helping people find, tell, create and publish the stories of their lives
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The KQED/DSI suggests several types of story styles you can use to 
create your digital story. Your instructor will show examples of each 
style to familiarize you with its format and be there to provide insight 
when you begin to conceptualize your project. 

A  S T O R Y  N A R R AT E D  W I T H  Y O U R  V O I C E
Stories created in a narrative style are the most personal in topic and tone.
Written in first person, narrative stories are narrated with your own voice.
Narrative digital stories are often the source of personal discovery and 
introspection, where we generally find out something personal about
the author. The story “drives”—or takes precedence over—the images; 
the meaning is expressed through the narrative and supported visually 
by the images. We will examine some useful methods to identify and focus 
a narrative story later in this chapter.

A  S T O R Y  W I T H  M U S I C
Most commonly recognized as music videos, this type of production is 
a story without words, although captions, titles and the blending of lyrics 
and visual imagery can personalize the piece.

A  S T O R Y  W I T H  I N T E R V I E W S  
Different people (including yourself) tell a story with interviews and the 
author provides supplemental images to support what is being spoken 
about. A common technique is to weave an entire story through the voice 
and reflections of others; this method is enhanced through multimedia 
technology, which allows voices to be heard while different images are 
seen. A story using interviews can also be mixed with a story including 
narrative. We will explore tips for effective interviewing later in this manual.

Story Styles



3A well-crafted digital story is a seamless blend of multimedia technology and
the inherent ability to find meaning in our experiences and tell that story. While
technical skills are easily taught and usually just as easily learned, identifying a
compelling personal story and translating it into narrative can be a difficult and
overwhelming experience. Some people who are completely capable of sharing
a story in casual conversation become apprehensive at having to prepare a
story in script form for their digital story. Perhaps there is an element of fear in
the notion of creating something tangible or permanent and “getting the story
right.” It is helpful to remember that these are your stories. How they are told
and supported through visuals is a unique and individual process; there is no
one correct approach. However, to help identify your story and tell it effectively,
the KQED/DSI recommends these key processes in eliciting stories that have
proved successful with a broad range of students.

A B O U T  S T O R I E S
Our identities are filled with stories, which provide insight into who we are.
Stories mined from our lives are a direct connection to what our experience on
the human journey is. Stories can explain and illuminate:

Who we are
Where we came from
Where we are going
What we care about
What is important to us

A good story has a beginning, middle and end. Make the beginning captivate
your viewer. Perhaps frame it with a question, dilemma or controversy. It should
compel us to continue to watch; we want to see how the problem is resolved.
The middle describes the course of events: What happened? The end of a story
reveals a conclusion: How did the situation turn out? The story’s end is also a
good place to present your meaning or point. The experience of watching and
hearing the story should leave us changed or wanting to learn more.

S T O R Y  I D E A S  A N D  T H E M E S
Ideas and inspiration for personal stories can come from many sources. Your
KQED/DSI workshop instructor will show examples of digital stories created by
former students, then lead a discussion of classic story themes. She will also
assist with memory trigger and brainstorming exercises to help you identify a
story you feel is meaningful to tell. Here is a small selection of common story
themes. Yours need not fit into one or any of these categories. Once you begin
to think about stories using common themes or memory triggers, you will find
the possibility for a story worth digitizing is endless!

Narrative Theory: Finding Your Story
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Some common personal story themes include:

R E M E M B R A N C E  O R  M E M O R I A L  S T O R I E S
Stories that acknowledge, honor or reflect on the life of one who has died.

R E L AT I O N S H I P  S T O R I E S
Stories of significant relationships in your life. Common subjects are immediate
relations, including parents, grandparents, siblings, spouse or partner. Other
meaningful relationships may include a business or creative partner, a teacher
or mentor, childhood or lifelong friends, even pets. Who are these subjects and
what impact have they made on your life? Consider including stories of love,
admiration, longing or loss, disappointment or a poignant reflection of a person.

T H E  G E N E S I S  S T O R Y
Almost all people, groups or businesses can point to a significant moment or
event in the past that was a determining factor in how things are today, e.g., 
“If my mother had not taken a ceramics class, she would not have met my
father….” The genesis story is an essential part of almost all family histories,
examining the question, “Where do we come from?”

S T O R I E S  O F  C H A L L E N G E
Stories in which you have experienced challenge and how (or whether) you
overcame it. They can be physical as well as mental challenges, i.e., the 
challenge of climbing a 15,000-foot mountain, conquering the fear of changing
careers or returning to school after an extended absence. 

O B J E C T S  A N D  A R T I FA C T S
All of us have owned or known of a possession that held tremendous value in
our lives and the compelling stories that accompany them. Objects or artifacts
can be as varied as a lucky charm, a rock found on a memorable hike or a 
precious family heirloom handed down through many generations. What are
these objects, how do they exist in your life and what value do you place 
on them? 

H U R T  A N D  H E A L I N G
Sadly, it is guaranteed that human beings will experience at least some element
of emotional suffering. Stories about pain and the healing process are ultimately
about resurrection and finding a way to continue. These types of stories can be
about hurt and how that changed you.



S T O R I E S  A B O U T  A  P L A C E
Stories about locations, specific or vast, capture memories. Geographical
places hold intense memories and emotional significance in our lives. 
Whether you have a fond memory of spending childhood summers on 
a grandparent’s farm or the painful recollection of a war combat zone in 
a distant country, reconciling stories and emotions of these places is a 
useful exercise in understanding ourselves—we might refer to it as narrative
archaeology: What’s buried in this place?

A D V E N T U R E ,  J O U R N E Y  O R  T R AV E L
This theme is an abundant source of stories, for we have all had some sort of
journey or travel experience that can be told as an adventure.

T H E  S H O E  B O X  O F  S T O R I E S
Countless stories can be found in the well-worn shoe box or photo album filled
with our treasured photographs. Each photo preserves a moment in time and
each moment has a corresponding story: “Where was I when this photo was
taken? Who took it? Who is in the photo with me? What was I thinking when
this was taken?”

Conceptualize Your Story: Narrow the Focus

Once you have decided on a particular theme or topic for your story, you 
begin the process of planning how the story will be told. At this point, it is 
often necessary to narrow your focus. Telling the entire history of a beloved 
grandfather in a single short story could be an overly ambitious task. It is often
hard to know where to start a story with a broad topic, and usually harder to
know when to end it. By thinking about a particular aspect of the relationship
that was important to you or a specific event you shared—perhaps relating a 
bit of wisdom or transformation that occurred—you conceptualize a core story.
Questions to consider in this order narrow the focus of your story:

What is the main question or problem this story will explore?
What events or experiences occurred that will help to tell this story?
How did it end? 
How did I feel (in the beginning and at the end)?
How was my perspective or viewpoint changed?

5



Conceptualize Your Story: A Point of View

Having and expressing a point of view is critical to any good story. All stories
are told to make a point from a particular perspective. Without a point of view, 
a story is reduced to a mere recitation of facts. If the point is to tell something
about yourself, it will be helpful to incorporate something emotionally engaging,
something you care deeply about. A point of view allows others to understand
how you feel about your story and what compelled you to tell it in the first
place. Emotional points of view can be derived from:

A dream
A wish
A disappointment
A fear
A belief
A loss
A discovery
A success
Something exciting

Conceptualize Your Story: Voice
The sound of your voice is unique and special. In digital storytelling, we talk of
the voice, both as what it means in audible terms as well as in its narrative and
storytelling terms. For digital stories that are created in a narrative style, we 
recommend using your own voice for several reasons. First, if the story is a 
personal one, who better to narrate it than you? Your voice, your manner of
speaking, your inflections and tone all identify you, which will add authenticity
and a sense of identity to your story. When writing your script, we recommend
you include elements of your unique phrasing style and sentence structure.
Narrative writing has a different cadence and rhythm than business or other 
formal forms of writing. More organic, it resembles the manner in which you
naturally speak. By embracing your voice both in writing the script and for the
narration, the ownership and authorship of your story become wholly yours.



Conceptualize Your Story: Audience

In any created piece, you must take the audience into account. In broad
strokes, the audience for every piece is a general audience, but on closer
inspection, we often have a specific person or group of people in mind.
Answering these two questions will help to define your audience:

What do I really want to say?
To whom do I want to say it?

The first question will lead you to better communicate the meaning behind 
your story; the second will aid you in discovering the embedded audience. 
To discover your real audience, ask yourself who really needs to hear it.

Understanding who your audience is will lend insight into appropriate tone 
and diction. You could relate the same experience to three different people 
and, depending on who they are, the story will be different even though the 
experience is the same. The way you tell a story to your mother is very 
different from how you tell it to your best friend. Knowing your audience 
will help determine how to best to tell this story. 
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Telling stories is one of the most powerful methods humans have for sharing
meaning and understanding with one another. Human stories are unique in 
that each individual’s account will be different than another person’s, even 
if the exact same experience happened to both people at the same time. 
People have different perspectives and thus story their lives unique to their 
interpretation and identity. The process of examining a story, reconstructing 
it through narrative and ultimately releasing it in a tangible form alters the 
experience from one person’s internal account into one available for 
internalization and interpretation by others. By this act of conscious 
release, a story is transformed. 

The restorying process can be used as an agent for personal change and the
transformation of a negative experience into a positive one. As a therapeutic
application, storytelling is a technique that encourages people to analyze 
events and relationships clearly and put them into perspective. This process
grants permission for a negative or stressful situation to be developed into a
positive or resurrective narrative. The concept is simple: you can’t change what 
happened, but you can change where you stand in relation to that story. That is,
you don’t need to stand in the victim’s place. If you retell the story, you become
the author. Through that reauthoring process, the story gets rewritten according
to your version of it.

The Restorying Process
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Up to this point, we have focused our discussions on defining digital story-
telling. We’ve also offered suggestions on how to think about a story you would
like to tell and the various story styles you can use to visually express your
story. In this chapter your story will begin to take shape. You will learn how to
create a storyboard, then begin working on the computer to organize and digi-
tize your materials in preparation for the video edit. 

Creating a storyboard for your digital story is an important and necessary
process for visualizing what your story will look like in its completed form. The
digital stories made in this workshop are time based—they progress across
time in a linear format. A storyboard is a visual road map that allows you to
organize what you will be seeing and hearing as your story moves from begin-
ning to end. Creating a detailed storyboard in advance of the editing process
helps you to think about the images (photographs, video, other types of art-
work) your story will need and provides a guide for you to follow during the edit.
Having a well-thought-out storyboard in advance of production reduces the
likelihood that you will end up frantically searching for visuals as you go along.

T H E  S T O R Y B O A R D  T E M P L AT E
We have provided a blank storyboard template at the end of the manual for you
to create your storyboard. Starting in the upper-left corner of the page, use the
square boxes for simple sketches or drawings to represent the visuals that will
be taking place. The space beneath the boxes is used to indicate the audio that
accompanies the visual. It is not necessary for you to include the entire text of
your script in this space, but it may be helpful to include the beginning and end
of the audio portion for each panel so you are clear on exactly what will be said
in that section of the story. 

Move from left to right, filling in the panels with script and key images as you
go. The final panel should be the end of the story, and don’t forget a panel for
credits! How detailed you make your storyboard is up to you. If this is your first
digital story, you may wish to organize your storyboard so each scene change
is a new panel. You may prefer to create your storyboard based on the script,
with a new panel for each sentence. The main thing is for your story script to be
complete and for you to be familiar with all the images needed to support it and
to know exactly where they will be used. As you move into the next sections of
this manual and begin working on the computer, keep your completed story-
board handy for reference. And remember, your storyboard is a map to guide
you—it is not set in stone, and it will likely change as you start to create your
piece.

Creating a Storyboard



We have provided a blank storyboard template at the end of the manual for you
to create your storyboard. Starting in the upper-left corner of the page, use the
square boxes for simple sketches or drawings to represent the visuals that will
be taking place. The space beneath the boxes is used to indicate the audio that
accompanies the visual. It is not necessary for you to include the entire text of
your script in this space, but it may be helpful to include the beginning and end
of the audio portion for each panel so you are clear on exactly what will be said
in that section of the story. 

Move from left to right, filling in the panels with script and key images as you
go. The final panel should be the end of the story, and don’t forget a panel for
credits! How detailed you make your storyboard is up to you. If this is your first
digital story, you may wish to organize your storyboard so each scene change
is a new panel. You may prefer to create your storyboard based on the script,
with a new panel for each sentence. The main thing is for your story script to be
complete and for you to be familiar with all the images needed to support it and
to know exactly where they will be used. As you move into the next sections of
this manual and begin working on the computer, keep your completed story-
board handy for reference. Remember, your storyboard is a map to guide you—
it’s not set in stone and will likely change as you start to create your piece.

O W N E R S H I P  O F  M AT E R I A L S
Before we move on to the details of digitizing your materials, we’ll briefly
address the issue of ownership of materials and using materials in your digital
story that you don’t own. When you are considering and gathering images and
music for your digital story, keep track of who owns or created the images and
sounds you plan to include. Using materials that are exclusively owned by
you—meaning you took the photograph, created the artwork, wrote the sound-
track—ensures there are no copyright infringement implications. However, as a
beginner, you probably don’t have all of the materials you need and will there-
fore need to supplement your story with images and sounds created by others.

The Fair Use Policy of the Copyright Law of the United States of America tradi-
tionally allows you to use someone else’s work of art to create a new work of
art. However, record and entertainment lawyers contesting this approach are
attempting to redefine the Fair Use Policy to mean no use without permission or
likely compensation. Copyright attorneys are deep in battle, so stay tuned for
further developments. In the meantime, if you choose to use images or music in
your digital story that are not your own, please acknowledge and credit the
author of the material.

Digitizing Assets

1 Webopedia www.webopedia.com
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P R E PA R I N G  V I S U A L S
Visuals are essential to a good digital story. Images used for the video portion
of your digital story reinforce the audio as well as help move the story forward
and provide context. Visuals can be photographs, video, scanned memorabilia
(newspaper clippings and other flat art) and artifacts. Following are processes
for digitizing various forms of visuals.

C A P T U R I N G  ( S T I L L )  P H O T O S  F R O M  A  D I G I TA L  C A M E R A
Photographs taken using a digital camera are ideal for digital storytelling pur-
poses because they do not require resizing or alteration of the pixel resolution
before use. For the most part, digital cameras, regardless of brand or model, do
not need software to transfer, or download, the photographs to a computer. The
most commonly used camera storage devices are memory cards and memory
sticks. Depending on your computer, some of these storage devices can be
inserted directly into the equipment. If your computer does not provide for an
internal reader, an external reader can be used. Such readers are connected to
the computer via a digital cable, and they may require software for operation.

When read correctly by your computer, your digital photographs will appear in a
folder on your computer desktop. To view them, double-click the folder to open
it, then select each file (the photographs will likely appear as .jpg files) by dou-
ble-clicking it. Select all of the photos in the file by selecting All (Apple or
Command + A/Ctrl + A) and double-clicking the selection.

In some cases, Apple’s iPhoto application will launch automatically to view the
photos. It is your choice whether or not to use iPhoto to organize your photos.
We suggest organizing all of your digital storytelling project files, including pho-
tograph files, in a separate folder on the desktop. For simplicity, name a folder
with your name followed by the word “Materials” (example: Leslie Rule
Materials). Create subfolders to hold categories of materials, such as “Scans”
and “Photographs.” Move your desired photos from the digital device folder
into your Photographs folder by selecting, then dragging and dropping them. 

Create the following folder structure on your desktop to contain your materials:
Folder: Leslie Rule Materials
Subfolder: Scans
Subfolder: Photographs



13S C A N N I N G  N O N D I G I TA L  M AT E R I A L S
Although preparing digital photographs for your digital story is relatively
straightforward, some of the images you wish to use may not have been creat-
ed digitally and therefore will need to be digitized before they can be included.
To digitize hard-copy materials such as photographs, memorabilia, articles and
artifacts, use a scanner. Scanning is an easily learned skill, but requires more
time than merely downloading images from a digital camera. 

To scan materials, be sure you have a scanner that is compatible with your
computer and that the necessary scanning software installed. (Adobe
Photoshop and Adobe Photoshop Elements both have the ability to import
scans. Check their Help sections for information regarding installation of the
necessary plug-ins.) A flatbed scanner will accommodate almost all still photo-
graphs and hard-copy materials and may include an adapter for scanning
slides. 

Scan your material at 300 dpi resolution. Save all of your scans in your Scans
subfolder and title each scan file as clearly as possible so you can identify the
content by its name. For the purposes of digital storytelling, save your scans to
your computer in jpg (pronounced jay-peg) format. An example of a correctly
titled and saved scan would look like this: redflower.jpg. 

If you have a lot of photos or other memorabilia, you may want to scan several
items at once, saving the group scan as a single file. You can reopen this file at
a later time and use the cut and paste functions or the Divide Scanned Photos
option in Photoshop Elements to separate single images into new individual
files. 

E N H A N C E  P H O T O S  U S I N G  A D O B E  P H O T O S H O P  E L E M E N T S
Very few photos are perfect. When you examine yours with a critical eye, you
may notice that some are faded or yellowed with age, over- or underexposed,
crooked, even out of focus. Depending on the context in which these images
are to be used, these imperfections can add authenticity to your story—but
they can also be distracting.

One of the wondrous features of working with digital imagery is the ability to
color-correct, enhance and edit the images using software created specifically
for these purposes. The KQED DSI recommends software by Adobe Systems.
For the beginner, Adobe Photoshop Elements, available for both the Mac and
the Windows platform, is an affordably priced, yet powerful consumer-level
enhancement and organization application designed for anyone wishing to
improve or alter their photographs. 



For the more ambitious and experienced user, Adobe Photoshop is the profes-
sional-level version of Elements. It is an industry standard, and although it costs
significantly more than Elements, it is a much more in-depth application, capa-
ble of advanced digital image enhancement as well as graphic and Web design
functions. 

Before you import your photos into iMovie or Movie Maker, the KQED DSI rec-
ommends taking a few quick (five minutes) and easy steps to improve any
photo by 90 percent. These steps include: rotating, straightening, cropping,
correcting color, and using the clone stamp tool and, if needed, the red-eye
correction tool. Take a few minutes to apply these easy enhancements to each
photo and you will see a dramatic improvement in your photographs! 

To begin using Photoshop Elements, double-click the application icon (a digital
camera) in the dock of your Mac or on the desktop in Windows.

Open an Image
Open an image that you wish to alter/enhance by using the standard File>Open
approach and navigating to a target image, likely located in your Scans subfold-
er. If the image you want to work on happens to be part of a group of multiple
scanned images, you can easily separate the individual images by choosing
Image>Divide Scanned Photos. Notice that each image separates from the
group scan and is now its own individual copy located in the Photo Bin in the
lower portion of your workspace (you may need to un-collapse the Photo Bin
area to view the photos). Divide Scanned Photos may not place the images into
their correct orientation, but it does apply an automatic straighten pass that
may be sufficient. If further straightening is necessary, refer to the Straighten
and Crop section below. 

Open an Image



15Rotate 
The first step to improve your image is to make sure the orientation of the
photo is correct. This means that people, buildings, landscapes—whatever your
subject—should be facing in the correct direction. To rotate a photo, choose
Image>Rotate and select the correct direction, 90º left or right. You may need
to rotate more than once. You can also flip images horizontally or vertically to
suit your purposes. Name and save your work.

Straighten and Crop
Materials that have been scanned manually often appear crooked. As is true
with many software applications, Adobe Photoshop Elements offers several
methods for straightening. Elements’ Straighten command provides automatic
straightening and its Straighten and Crop command automatically straightens
and crops. To use the Straighten command, choose Image>Rotate>Straighten.
Try the Straighten and Crop command by choosing Image>Rotate>Straighten
and Crop. If the results are not to your liking (and they probably will not be),
you can undo the action by pressing the Apple (or Command) + Z or Ctrl + Z
keys simultaneously. To have more control over straightening your image,
choose the Straighten tool from the Tools palette. The Straighten tool works on
the premise of straightening along a horizontal line. Try to locate a clear hori-
zontal line in your image and drag out a line from end to end; Elements will
automatically straighten the image along the horizontal line. When using the
Straighten tool, choose the Grow or Shrink to Fit option from the pull-down
menu in the Canvas Options; this will provide more flexibility and control in the
cropping process. Also, check the Rotate All Layers box, even though you
may be working with only one layer. 

You can dramatically shift the attention from one part of an image to another
part of the image by using the Crop tool. Ask yourself where you want the
focus of this picture to be, then crop accordingly. For example, if you are using
a photograph featuring people central to your story, but in the background of
the photo is an airplane that is not relevant to the story, crop the image as close
to the people as possible and delete the portion containing the plane.

To crop a photo, select the Crop tool from the Tools palette. Use your mouse to
click and drag over the part of the image you want to keep. When you release
the mouse button, a bounding box is now in place. The area inside the box is
what you wish to keep and the area outside the box (in the shaded area) will be



Crop tool

discarded. If you are not happy with the crop you have selected, press the ESC
key, which will remove the bounding box. You can then redraw your crop. You
may also use the handles on the corners and sides of the crop to reposition the
crop as desired. When you are satisfied with the areas to be retained and to be
discarded, complete the crop by clicking Enter or by clicking the green check-
mark located at the lower-right corner of the crop box. Cancel the crop by
clicking the red Cancel button. 

Helpful Hint: In setting your crop, remember that you are preparing images for
use in a video production where the aspect ratio is horizontal (wider as opposed
to taller). Although most desktop video editors automatically scale images to fit
their aspect ratio, for the best-looking results in your digital story, select a crop
that is approximately 4 lengths wide to 3 lengths tall. If you prefer to set a pixel
size to help you set a crop, set the crop width to 4 inches and the crop height
to 3 inches. This will give you an idea of what the horizontal aspect ratio will
look like. An image that is cropped vertically (taller than wider) will appear small-
er in the video edit because the video editor will accommodate for the aspect
ratio of the image and will automatically insert a black background to fill in the
empty horizontal space that does not contain part of the image. 

Once the crop has been made, save the cropped image as a new (separate)
file. To do this, choose File>Save As. If you just do a regular Save instead of a
Save As, you will lose the original image and be left with only the cropped one.
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17Correcting Colors
Photoshop Elements provides nearly endless possibilities for correcting and
adjusting the color of images, including a series of automatic functions
accessed through the Enhance menu. These automatic processes include
Auto Smart Fix, Auto Levels, Auto Contrast, Auto Color Correction, Auto
Sharpen and Auto Red Eye Fix. Although these automatic functions may pro-
vide successful results, there are other options that can target specific color
problems. Here we will detail instructions for several processes to help you dra-
matically improve the color quality of your photos. 

If you are using older scanned photos in your project, you may notice that, with
age, some photos may have developed a cast of color. This color cast can
often be easily corrected by choosing Enhance>Adjust Color>Remove Color
Cast. Following the instructions in the dialog box, use the eyedropper tool to
choose a part of the image that should be gray, white or black. Elements will
adjust the photo based on where you click. You can move the dropper around
and review the results as you go until you find the result you like. Click OK to
accept.

Adjust the hue and saturation of your photos by choosing Enhance>Adjust
Color>Adjust Hue/Saturation. This process is helpful for correcting color satu-
ration (purity of color) and hues (colors) in photos whose colors look washed
out or oversaturated.



Another option for adjusting the overall color balance of your image is to use
the Color Variations option. Choose Enhance>Adjust Color>Color Variations.
This option operates on a color wheel theory, in which by adding one color you
subtract from another. Select an area of the image to adjust, such as the default
midtones, then adjust the color intensity by increasing or decreasing Red,
Green or Blue. You may also Lighten or Darken the image. Preview your
changes in the before-and-after area until you are satisfied with the results, then
click OK to accept.

Adjust the skin tones of your human subjects by using a function
specifically designed for this task. Choose Enhance>Adjust
Color>Adjust Color for Skin Tone. Then click an area of the sub-
ject’s skin tone and Elements will attempt to improve the color.
You can also make adjustments by adding or removing yel-
low/orange to/from the skin tone using the Tan slider, and you
can increase or decrease the amount of red/pink in the skin tone
using the Blush slider. Adjust the overall temperature of the
photo with the Temperature slider, from cool on the left to warm
on the right. Preview your work until you are satisfied; use the
Reset button to begin again. 

Adjust the brightness and contrast of your image by adjusting the
luminosity levels. Choose Enhance>Adjust Lighting>Levels and
a histogram bar graph in the center of the dialog box represents
the luminosity, or brightness, levels in the image, from blacks to
whites (left to right). Start the process by clicking the Auto button;
the levels will now be spread from the shadow (black) to the high-
light (white) areas of the histogram. Make the midtones lighter or
darker by moving the middle slider to the left or right. To apply
changes, click OK.

Red-Eye Removal and Retouching
Red-eye is an undesirable by-product of a photograph taken
using flash, and Photoshop Elements offers a tool specifically to
remove red-eye. First, zoom in to a comfortable level to clearly
see the red-eye. Next choose the Red Eye Removal tool from the
Tools palette and position it in the area of the red-eye. Place the

cursor in the target area and click the tool once; Elements will process the
results and turn the red-eye area of the iris black. If the result is not satisfactory,



undo it by using Ctrl + Z/Apple or Command + Z and try again by repositioning
the cursor in a different area of the red-eye.

The Clone Stamp Tool
The clone stamp tool is a useful way to easily add or subtract a portion of
image (also known as montage) and retouch imperfections in your photographs.
To touch up an undesirable blemish from your photo, first select the Clone
Stamp tool and position it in an area that has the color you wish to use as a
replacement color. Select an appropriately sized brush from the pop-up palette
in the Options bar or use the keyboard commands of left or right bracket (to the
right of the P key) to increase or decrease brush size. Next, click and hold the
mouse while pressing the Option (Mac) or Alt (Windows) key; this will pick up
the targeted color. Move your cursor to the area you wish to brush out and click
your mouse. The color you have previously picked up is now dropped in,
replacing an undesirable color or area. Repeat by moving your mouse and
clicking, continuing to replace the color until you reach the desired effect.

This same action can be used to paint in a montage from the same or another
active photo window. To create a montage by selecting an element from one
picture and moving it to another, follow the same procedure as for correcting a
blemish. If you are planning on moving a large element of a photo, use a larger
brush. First, select your desired brush size. Next, select the Clone Stamp tool
and collect the pixels located in your target area by clicking and holding the
mouse while pressing the Option/Alt key. Then place them in another area of
the same photo or in another active photo window by holding down your
mouse button and “painting” in the image. 

Adobe Photoshop and Adobe Photoshop Elements offer many creative options
for enhancing and editing your photos. To get the most from these applications,
we recommend spending some time looking at the various features available
and experimenting with them. You can also utilize the Help function to search
by subject for useful instructions and tips to better use the software.

Brush

19



The KQED DSI used software created by Apple to edit digital stories. The iLife
Suite is a collection of software applications developed by Apple to work seam-
lessly with each other to manage, enhance and help you create your multimedia
collections and projects. Although the newest machines are shipping with the
updated iLife 08 Suite, we prefer to use the 06 version of iMovie because of a
radically redesigned interface that is much less intuitive. We do use the other
applications in the newer iLife 08 Suite. You can use either. There is a free
download of iMovie 06 at www.apple.com/support/downloads/imovieHD6.html.
The iLife 06 Suite contains: iMovie HD, a video editing application and the pri-
mary tool used by KQED workshops to edit a digital story; iPhoto, a photograph
organization tool; iDVD, for creating and burning DVDs; iTunes, for managing
and playing your music collection; Garage Band, a sound production applica-
tion that allows you to score your own arrangements; and iWeb, an innovative
application that makes it easy to create custom websites.

KQED teaches iMovie as its video editing solution for several reasons. The
KQED DSI computer lab is taught on the Mac platform and iMovie was devel-
oped for Mac using its own operating system. iMovie’s low cost is also a deter-
mining factor—it is included free with all new Mac purchases and is an intuitive,
easy-to-learn program that is fun to use and provides results with very high pro-
duction values. 

Let’s take a look at the structure and features of iMovie HD. In order to work
efficiently, you should understand how to open or “launch” the software, how to
name your work, how to import your prepared materials, and how to resume a
project if you stop working for a while. 

Organizing Your Computer to Work:
File Management in iMovie

Dock iMovie HD



By default, with the Mac OSX operating system all of the iLife 06 Suite applica-
tion icons are located in the dock of your computer. To launch iMovie HD, dou-
ble-click the iMovie icon, which resembles a film clapboard for iMovie 06 and a
star for iMovie 08. 

When you open iMovie HD, it will open up the last project your were working
on. If you have not yet started a project, it will open a welcome screen. This
welcome screen appears first and will prompt you to Create a New Project,
Open an Existing Project or Make a Magic Movie. The welcome screen also
offers the option to Quit. You will be starting a new project, so select Create a
New Project. A standard Save dialog box will prompt you to name your project
and to save it to a desired location on your computer. For easy recognition, we
recommend you title your project using your first and last names (Project:
LeslieRule) and save it to your desktop. Your new iMovie HD project file is rep-
resented by a clapboard/star icon.

The next time you open iMovie, the program will automatically open the most
recently named project. This allows you to continuing working where you left
off. If you prefer to open another iMovie file, choose File>Open from the pull-
down menu. If you wish to return to the welcome screen, choose File>Close
Window (you will be prompted to save any open work) and the screen will
return to the iMovie HD welcome screen. 

A significant change from previous versions of iMovie is the look of the Clips
pane. A new pane is the Editing pane, which contains tabs for Titles,
Transitions, Video FX and the new Audio FX. Also new, the Media pane now
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combines access to your Photo and Audio elements. Previously they were sep-
arate panes. The functionality remains the same—you can still access your
iTunes and iPhoto libraries—but they are now within the Media pane. 

Another significant change in iMovie HD from previous versions is the manner in
which iMovie imports and manages media assets. Traditional methods of
importing media are still available; you can still import media by choosing
File>Import, navigating to a target file or folder, and choosing Open. iMovie will
import the material selected. Another option for importing is to drag and drop
acceptable format files directly from a folder onto the Clip pane. Keep in mind
that iMovie HD does not recognize .wma files and will not import them. 

Although those methods do work, the preferred manner of managing your work
is via the new Media pane. By preparing all of your images in advance, saving
to a folder on the desktop and then moving the folder of final images into your
iPhotos library, you will be able to easily access your images via the Media
pane by using the Photos tab. Move your folder of images into iPhotos by
selecting the target folder and dragging it directly onto the iPhoto icon in the
dock. iPhoto will automatically import all of your images. Once the import
process is complete, you can order your images as you like by creating albums.
First Shift+Click to select all of the desired images you want to place in order,
then click the + button at the far lower left of the iPhotos window and create a
new album. The images you have selected will now be placed into the newly
named album. 

The same approach—ordering your files in advance—is advised for audio
assets. Prepare a folder on your desktop to contain your audio files, both your
voiceover narration and your sound tracks. Move this file into your iTunes

Media Pane



library. Then you are able to access these files from the Audio tab of the Media
pane. To move a folder from the desktop into iTunes, simply click the folder and
drag it onto the iTunes icon in the dock. iTunes will automatically import the
contents of the folder into the library. Create new playlists, if desired, by clicking
the + button located in the lower-left corner of the iTunes window. 

iMovie HD has added these intuitive methods of working in order to make the
production process more integrated among the suite of iLife tools. Used in the
manner suggested, you will find working with iMovie a fun and easy way to give
life to the stories you plan to create.
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Creating the Piece

Hardware and Software: 
Getting Your Gear Together

Editing Video

Editing Audio

C H A P T E R
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Besides exceptional stories, one outcome of students taking a KQED Digital
Storytelling Workshop is the desire to create more digital stories on their own
equipment! Some may already have a computer and need only to add function-
ality, whereas others may not have a computer and will need to start from
scratch. And although computers continue to become more affordable and
accessible, most people still consider them to be a major purchase. Therefore,
it is important to know exactly which equipment is necessary for creating digital
stories.  

H A R D W A R E
“Hardware” refers to the actual computer you will use to create the work. It also
encompasses other important items, including scanners and printers. As men-
tioned in Chapter 2, it is essential to use a computer with enough processing
power and hard-drive storage space so you do not become frustrated by slow
processing time or run out of space to contain all your materials.

When it comes to computer hardware, “the bigger, the better” is generally true.
The larger the processor, the faster the work can be done; the bigger the hard-
drive storage space, the more data it can store for you to access. Luckily, many
formats of digital storytelling, including short movies, do not require the fastest
or most powerful machine. And although Mac and PC operating systems are
becoming increasingly more similar, we recommend and use Apple products in
our lab.

Apple released its first personal computer in 1984 with the expectation of its
being a personal computer for all of us. Its operating system was intuitive, and
emphasis was less on the computer as a business machine and more on its
capabilities as a desktop publishing machine. Apple began to focus on its com-
puters’ multimedia production capabilities shortly after they were introduced.
Early pioneers and creators of digital stories preferred using Mac machines to
Windows PCs for this reason. For the first time, nonprofessional producers had
access to machines capable of multimedia and video production. Through the
years, Apple has continued to place a priority on the multimedia and video pro-
duction functionality of its machines. Today, the ease of use direct from the box
allows even first-timers to achieve remarkable results right from the start. 

S O F T W A R E
As interest in digital storytelling and consumer media expands, so do the soft-
ware application options available to help you tell your story. We use—and
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teach you how to use—a set of software tools that have become the standard
for digital storytelling, but other applications exist that you may wish to consid-
er, depending on your budget and your digital storytelling goals.

R E C O M M E N D AT I O N S  F O R  M A C I N T O S H  A N D  W I N D O W S  –  
I M A G E  E D I T I N G
The image editing software of choice is the Adobe Photoshop series, created
by Adobe Systems Inc. Adobe typically develops software that is identical for
both PC and Mac users. We recommend Photoshop Elements for beginners
and photography enthusiasts. Considered to be the “little brother” to the pro-
fessional-level Photoshop, Elements provides a wide range of useful editing
tools as well as automated Quick Fix options. The cost of Photoshop Elements
for both Mac and Windows platforms is approximately $80. The professional-
level Photoshop moves up the scale in capability, power and price. Photoshop
is the professional standard for graphic, Web and video designers as well as for
professional photographers. Photoshop is available in several bundled profes-
sional Creative Suites, with prices beginning at about $650.

R E C O M M E N D AT I O N S  F O R  M A C I N T O S H  –  V I D E O  E D I T I N G
For Mac computer users, the video editing software of choice for the KQED/DSI
workshops is iMovie 06. As mentioned in Chapter 2, iMovie was developed by
Apple as part of the iLife Suite, a set of integrated software tools for your multi-
media lifestyle. iLife is included free with the purchase of any new Mac comput-
er. The suite can also be purchased for about $80 at Apple retail stores and
online at www.apple.com.

In addition to iMovie, Apple has also created Final Cut Pro Express HD and
Final Cut Pro 6 for digital video production. Final Cut Pro Express HD is
designed for a wide range of users, from beginners to experienced video edi-
tors. Its price of approximately $300 is obviously more than pocket change, but
it’s a good investment for the user who is serious about learning to edit digital
video. Professional digital video editors consider the more advanced Final Cut
Pro 6 to be a standard in the industry. It is a powerful tool and comes bundled
as part of the Apple Final Cut Studio 2, which sells for about $1,300.

We also extend a warm “welcome back” to Adobe Premiere Pro CS3 for the
Mac. Absent from the Mac platform (and also from the PC platform) for several
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years, Premiere Pro returns as a start-to-finish solution for efficient and profes-
sional video production as well as for seamlessly integrating media from the
entire Adobe family of products. Adobe Premiere Pro prices begin at around
$800.

R E C O M M E N D AT I O N S  F O R  W I N D O W S  –  V I D E O  E D I T I N G
TThe Windows XP operating system includes a free movie-editing application
called Microsoft Movie Maker. It is intended for beginners and home video
enthusiasts and is well suited to teaching those who are new to digital story-
telling the basic concepts of editing and storyboarding. 

Also, Adobe has created tiered-level video editing software for Windows com-
puters similar to Photoshop Elements and Photoshop: Adobe Premier Elements
is suitable for beginners and home video enthusiasts, and Adobe Premiere Pro
is suitable for professionals. 

Adobe Premiere Elements offers ease of use for home video editing projects,
and at about $100, it’s priced for the beginner and enthusiast. As noted above
in the Mac section, Adobe Premiere Pro is once again available as a cross-plat-
form product for the professional video editor. Premiere Pro offers seamless
integration of media among the entire family of Adobe products. Premiere Pro is
available for Windows and Mac for about $1300.



Editing Video

29By this point in the DSI workshop, you should have finished digitizing all of the
still photographs, artwork and video you plan to use in your piece and all image
editing and enhancements of your photographs and artwork. You should also
have completed the final draft of your story and recorded your script in Sound
Studio or Audacity.

We will now move to the creating the final story by editing the video and audio
together using Microsoft Movie Maker on the PC or iMovie 06 on the Mac.

If you have never edited video before, the concept is relatively simple. Even if
you have not consciously thought about it, you have been exposed to editing
just by watching television and feature films. Editing video on a computer is the
process of combining the materials, or assets, you have available as digital files
into a cohesive piece that plays from beginning to end. 

Using a digital (nonlinear) editing program allows you to access your material
instantly and repeatedly. The video editing process calls for making a number of
decisions around aesthetics, including clip length and timing, transitions
between clips, special video effects, titles, and audio and voiceover balance.
The next time you watch a movie, commercial or television program, pay atten-
tion to the length of a clip, or scene, before a change is made. Watch how the
transition from one image to the next is made: Is it a straight “cut” or does it
dissolve from one clip into the next? By observing how various transitions are
utilized, you will become aware of how different aesthetics contribute to a par-
ticular mood or feel. Also pay attention to the effect music has on the piece and
how a change of music can often elicit an emotion. 

E D I T I N G  I N  i M O V I E  H D  0 6
Tip: Working in iMovie will require as much available space on your computer
screen as possible. Move the dock to the left side of your screen for maximum
working space. 

Whenever you begin to work with a new piece of software, it is good practice to
review all of the pull-down menus to see what functions are available as well as
review the interface. If you have used an earlier version of iMovie, you will see
that many new features have been added in iMovie HD 06 and that accessing
material may be from a different pane or location. 



A series of Pane buttons, located on the Option bar, change the pane to vari-
ous tools that allow you to access elements you can add to your project. The
Pane buttons include: Clips; Themes; Media, which contains the Audio and
Photo panes, as did previous iMovie versions; and Editing, which contains
Titles, Transitions, Video FX and Audio FX, and Chapters. We will discuss the
functionality of these Pane buttons later in this chapter. 

Similar to iMovie’s previous versions, iMovie 06 has an interface structure that
comprises the Timeline, the Monitor and a series of Panes that provide con-
textual tools when selected. Let’s take a look at the functionality of each inter-
face component.

The Clips pane is the default pane when iMovie is launched. It is where all of
your images that are imported using the import function under the File menu
(photos, artwork and video clips) are stored for use in your movie. (Note that we
recommend iPhoto to import photos.) Each image you import into iMovie from
the Import tab drops into a square in the Clips pane, and you can scroll up and
down through the clips to locate a desired image. Think of this area as a shelf
in a kitchen cabinet—each time you need an ingredient (an image), you return
to the shelf to get it. 



31The Monitor is the area in which all clips can be viewed and played back. Click
the Play button (forward arrow) to view the material assembled in the Timeline.
Click the double-left arrow to return to the beginning of the Timeline. Click the
arrow within a box to view your movie full-screen on your desktop. Notice that
as your movie plays, a vertical line, called a Playhead, progresses from left to
right through the Timeline. The position of the Playhead correlates with the
video and audio located in the Timeline. Use the downward-facing arrow button
at the lower-left corner of the Monitor to scrub, or move through, your movie by
controlling the Playhead along the Timeline. 

The Timeline is where you arrange your material in the desired order and where
you add the music, narration, transitions and special effects to your movie. The
Timeline has three tracks available in which to work. The top track is where the
visual clips are assembled; the lower two are for audio. For our needs, we will
use one audio track for the voiceover and the other for sound track and special
effects. The Timeline also has two “views” available in which to work. The Clip
view (represented by a film clip icon in the Options bar) allows you to see your
movie as it is arranged clip by clip, and it allows you to change the order of the
clips very easily. The Timeline view (represented by a clock icon in the Option
bar) allows you to see the duration time of each of your placed media and tran-
sitions. You can adjust the Zoom setting in the Timeline view to see your work
in greater or less detail. Both the Clip and the Timeline views are useful; once
you begin working in iMovie, you will find it is necessary to toggle back and
forth between the two modes to build your piece. 

Let’s take a closer look at the functions available through the Clips pane buttons.

Clips Pane
The Clips pane is where all of your images (video clips, photos, artwork) are
imported into iMovie. Preview the materials located in the Clips pane on the
Monitor by clicking the clip. If the clip is a video clip, press the Monitor’s Play

Timeline Tracks



button to preview the video. Arrange your clips into any desired order in the
Clips pane by dragging and dropping them. You can rename the clip by double-
clicking it and changing the information in the Clip Info dialog box. Identifying
your images with descriptive names can be very helpful when it comes time to
arrange them in the Timeline. Begin building your story by selecting desired
images (clips) from the Clips pane and dragging them into the Timeline, either in
the Timeline or the Clip view mode. Repeat the process to place still photo-
graph clips and video clips. Once placed in the Timeline, still photographs are
considered video, and you are able to adjust the duration (length of time) each
clip will play. To adjust the duration of a clip, double-click the image in the
Timeline and change the Duration setting. Remember that video editing oper-
ates using the measurement of 30 frames per second. Therefore, a duration of
3 seconds will read 03:00.

Understanding How Time Is Measured in Digital Video
When you begin editing with images and video clips, it is necessary to under-
stand how video is measured in terms of time. Video is measured in a unit of
time called a frame. There are 30 frames of video processed for each second of
video; conversely, each frame is 1/30 of a second. Video time is written with the
following structure: hours:minutes:seconds:frames. A timecode written as
01:30:12:10 is read as: one hour, 30 minutes, 12 seconds and 10 frames.
Familiarize yourself with this format because all indicators of time in video edit-
ing, including in iMovie, are given in this format. 

Themes Pane
Themes are predesigned animations that are a unique and fun addition to
iMovie 06. You access Themes via the Themes pane. Themes allow you to add
images, text and video to customize a theme-related, stand-alone movie that
serves to introduce your movie, to segue to your movie and to provide credits
for your movie. When completed, these animations can be added to a Timeline
and will play and behave in the same manner as any other clip. The Themes
available in iMovie 06 include Travel, Road-Trip, Pass Through, Reflection –
White, and Reflection – Black.

When you have selected a Theme, you are presented with a variety of Theme
Elements. Use the scroll bar on the right side of the Theme Elements window to
see the available options. The Theme Elements include Open, Chapter, Lower



33Third, Bumper 1, Bumper 2 and two versions of Credits. Choose a Theme
Element by clicking it, and it will load in the preview monitor.

As the Theme animates, gray areas appear in the animated sequence. These
gray spaces are referred to as Drop Zones, and you can drag and drop images
and video clips from the Clips pane, the Photos area of the Media pane and the
Timeline into the spaces provided in the Drop Zone window. You can change
the areas labeled Titles by typing a new title in the Themes pane. Render your
customized theme by clicking the Apply button in the Themes pane. The stand-
alone Theme animated movie will now be placed, as its own clip, in your
Timeline. 

Media Pane (Audio and Photos Combined)
Accessing Audio and Photo assets is now available in iMovie 06 from one loca-
tion, the Media pane. The Audio portion of the pane contains sound effects
available from three licensed libraries: Standard Sound Effects, Skywalker
Sound Effects and iLife Sound Effects. You can also access songs created in
GarageBand (Note: Be sure to select Save an iLife Preview when saving your
song in GarageBand in order to be able to access it in iMovie). The Audio tab
also provides access to your iTunes library, including podcasts and playlists.



Preview an audio selection by clicking it in the Media pane. When you are ready
to use an audio asset, click and drag the selection from the Media pane to the
Timeline. iMovie will import the music track and place it where the Playhead is
located. When the track has been successfully imported, a purple audio track
(visualized in waveform format) will be visible directly beneath the video track.
You can now select and move the audio track forward or backward in the
Timeline to align it with your movie. As you will likely experience, having a
sound track in place may require adjusting the duration of transitions and titles
in order to synchronize them to the music. 

We recommend that in building your digital story you use the top-level audio
track for your voiceover narration and the lower-level audio track for combined
sound track and sound effects.

There are other ways to import a sound track into iMovie if you do not have an
iTunes library. We’ll cover these as well as other sound-related issues—includ-
ing how to record a narration in iMovie using the built-in microphone in the
Audio pane—later in this chapter. 

The Photos tab of the Media pane allows you to seamlessly access all of the
images stored in your iPhotos library. Select images from the library, last roll or



35any of the albums that have been created in iPhoto. As images from collections
appear in the Media pane, simply click to select and preview them in the Monitor.

You’ll notice that the images you are previewing in the Monitor are moving. In
iMovie, this motion of a still image (whether zooming in or out or panning
across) is called the Ken Burns Effect. This is named for Ken Burns, the man
who popularized this treatment in his inspired documentary film projects in
order to add a sense of motion to still photographs. Applying motion to still
images is also at the heart of digital storytelling, as it is often these older,
pre–digital era photos that give so much meaning and authenticity to the stories
we tell of our past. We put motion on these images not only to keep the feeling
of movement and flow consistent throughout the piece, but also to draw atten-
tion to a specific item or person within the image—such as zooming in on the
face of a person who has been referenced in the narrative. 

To use the Ken Burns effect, you need to access the Photo Settings window
that appeared when the image was being previewed. If the window does not
appear automatically, click the Show Photo Settings button. First set the
amount of time you want the image to appear in the story by dragging the
Duration slider from rabbit to turtle (fast to slow). The maximum amount of time
available for a still image is 60 seconds. 

Next, set the desired motion, first by clicking the box marked Ken Burns Effect
to activate the Effect’s controls, then by moving the Start/End toggle into the
Start position. Next move the Zoom slider to where you want the zoom to
begin. For example, you may want to start with the camera pulled all the way
out, allowing you to view the entire image. Now move the Start/End toggle but-
ton to the Stop position and use the Hand tool to place the image at its final
destination point for the zoom. 



Check the results of your setting by clicking the Monitor’s Preview button. If
you’d like to see how the motion looks in reverse, click the Reverse button at
the bottom of the Photos Settings window. When you are satisfied with the
movement settings, drag the image from the Photos pane into the Timeline;
alternatively, you can click Apply from the Ken Burns window to add the image
to the Timeline.

The Ken Burns Effect is a great tool for digital storytelling. And although under-
standing how the tool works may take some practice and experimentation, we
encourage you to do this both to learn how to use the tool and to become
familiar with what is possible using zooming and panning techniques.

If you prefer to have a nonmoving version of your image, simply uncheck the
Ken Burns Effect box. You can still change the duration of the image using the
Duration slider, and when you are happy with your settings, add the image to
the Timeline by clicking Apply or by dragging it into the Timeline from the Photo
pane.

Editing Pane
New in iMovie 06, the Editing pane provides easy, all-in-one-location access to
Titles, Transitions, Video Effects and Audio Effects. Each tab of the Editing
pane is reviewed in further detail in the paragraphs that follow.

Titles
Using text in your story, in the form of titles and/or credits, is an ideal way to
add information and dimension. Text can punctuate your script, and in the
absence of a spoken reference, it can serve as supplemental information. The
use of credits, particularly crediting yourself as creator of this production, is
also very important. You worked hard on this story—be sure to give yourself
credit! Also be sure to credit any materials you used in your story that you did
not create, such as photographs, video and music.

To add a title to your digital story, click the Titles tab in the Editing pane. The
Titles pane will appear, offering a variety of title styles. Some title styles are
grouped with related options, which are available by clicking the downward
arrow located to the left of the title style. When you select a title style, a full-



37screen preview will appear in the Monitor. When you have found a style you
like, edit the title text, including selecting the font and its color and size as well
as adding or subtracting lines for credits and changing the speed and pause
timing of the title.

Titles tend to look best when they are added over a solid background such as
white or black or over a still photograph. Check the Over Black box to add
your title over black. To add a title over a still image, select the desired image in
the Timeline; the selected image will appear in the Monitor, allowing you to
visualize how the title style and settings will look.

Adjust the speed at which the title moves into place by using the Speed slider.
Adjust the duration of time the title remains in place by using the Pause slider.
Keep in mind that the amount of time the title will play is the sum total of the
Speed plus the Pause settings, and the maximum amount of time is based
upon the duration of the clip as set in the Timeline. 

When you have completed making your edits and timing adjustments, add your
title to the Timeline by clicking the Add button in the lower right corner of the
Titles pane. Once the title has been added to the Timeline, you can make
changes from the Titles pane and add them to the existing title by selecting the
target clip in the Timeline and then clicking the Update button in the Titles
pane. There are many fun and professional-looking styles, so be sure to exam-
ine each to find one that suits your style and story. Choose title styles that will
contribute to the feel of your story, rather than distract from it. 

Transitions
The next tab of the Editing pane gives you access to the Transitions pane.
Transitions are the visual effects that occur as one clip or image ends and
another begins. In television programming, transitions go mostly unnoticed, with
a straight “cut” being the standard method of moving from one image to the
next. Feature and documentary films use transitions more creatively, often with
fade-ins (transitioning from black to image or video) and fade-outs (moving from
image or video to black). Transitions can establish feel and emotion and can



also indicate a passage of time. For example, some action films use a radial or
clock wipe to indicate action, taking place in another location or time. We light-
heartedly refer to this as the “meanwhile, back at the ranch” transition. A cross-
dissolve is a transition in which one image slowly fades out as the next image
fades in over a set duration of time. The cross-dissolve is a visually elegant
transition, particularly when dissolving between still photographs, and it is a
very popular and appropriate transition for digital storytelling.

The process of
adding transi-
tions to your dig-
ital story is a sat-
isfying and
enjoyable part of
the production
process. Finally,
the emotional
attitude of your
story begins to
reveal itself, and
you can see how

the arrangement of music, narration, images and transitions all work together to
create a powerful result. Be sure to examine all of the transitions for style and
effect; we suggest using Fade In, Fade Out, Cross-Dissolve, Overlap, Wash
In and Wash Out. 

Working in the Clips view is the most efficient way of working with Transitions.
To add a transition, click the Transitions tab at the top of the Editing pane.
Before selecting a transition from the pane, select a location (two clips located
next to each other) in the Timeline where you would like to place the transition.
Select a transition from the Transitions pane, and a preview of what the transi-
tion looks like—using the chosen clips—will play in the Monitor. One of the
Transitions options available in iMovie 06 is Directional, which enables you to
adjust the direction in which the transition moves. A directional transition will
have a four-arrow button to allow you to control the direction. 

You may also adjust the speed, or how long the transition will take, by adjusting
the Speed slider; be aware that this is also the amount of time the total dura-
tion of your movie will be cut. A slightly frustrating aspect to adding transitions



to your story in iMovie is that a transition actually “steals” time from your story.
This is because a transition acquires its time duration by playing two clips at
once, depending on the speed of the transition. Keep this in mind when adding
transitions and be aware that a reworking of clip duration times may be neces-
sary. (Reset the duration of a clip by double-clicking the clip and adjusting the
time duration field.)

When you are satisfied with the look and speed of the transition, press Add in
the Transitions pane to add the transition to your Timeline. A red bar will appear
briefly under the Transitions icon in the Timeline, indicating the effect is being
rendered. 

A second method of adding a transition to your story is to click and drag a tran-
sition from the Transitions pane and place it between two clips. The transition
will render immediately; however, a preview will not be displayed. 

Delete a transition from your project by clicking the transition in the Timeline
and pressing the Delete key; notice that after deleting a transition, time taken
away from the clip duration is regained. Change the type of transition in place
by selecting the clip in the Timeline and choosing an alternative transition; click
Update in the Transitions pane to make the change.

Video Effects
Video FX, which brings up various options for video effects, is the next tab
available in the Editing pane. Video FX allows you to add even more visual
interest to your story beyond the titles and transitions you may have already
built in. iMovie 06 provides some very interesting and useful special effects that
can add texture and ambience to your story. 

To access the
Video FX pane,
click the Editing
pane button and
then the Video
FX tab located
at the top.
Similar in
appearance to
the previous
tabs we have
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reviewed, an assortment of available video effects appear in the pane. Working
from the Clips view in the Timeline, select a target clip to test the effect. When
you click an effect, a preview of that effect will play automatically in the Monitor.
Note that each effect may have additional controls and settings available; these
will be visible in the Video FX pane. Make any desired changes to the appear-
ance of the effect and then set the duration for Effect In and Effect Out. When
you have completed all of the settings, click the Apply button in the lower-right
corner of the pane to apply the effect to the selected clip in your Timeline. As in
the case of adding a transition, a red bar will appear in the lower portion of the
clip to indicate the effect is being rendered.

You can add more than one effect to a clip to layer effects. For example, first
apply an effect to turn the clip into black and white, then add a second effect,
such as Fog. In the case of multiple effects, you may wish to maintain the same
Effect In and Effect Out settings to make the effects play in unison on the clip.

When a clip has had a video effect added to it, an icon in the shape of a square
box appears on the top border of the clip to the right of the duration time. In
the case of multiple effects, a number will appear next to the box to indicate
the number of effects that have been applied. To delete an effect, select the
box icon and press Delete. The most recently added effect will be the effect
deleted. 

Video FX does not have an update function, so if you want to change an effect,
you must redo it. To make changes to an effect that has been rendered to a
clip, delete the effect, reselect the effect, make any desired adjustments and
click Apply. You may also apply a single effect to multiple clips by selecting the
desired clips in the Timeline. When the effect is applied, it will be applied to all
clips that have been selected.

Spend some time reviewing the video effects available to you in iMovie 06. You
might be surprised at how effective some of them may be and how they may
provide a special visual impact that makes your story come to life.

Audio Effects
New to iMovie 06 is the addition of Audio FX, which brings up various options
for audio effects. Use audio effects to alter, enhance or improve the sound of
your audio. To access the Audio FX pane, click the Editing pane and then the
Audio FX tab. Options for audio effects include: Graphic EQ, Reverb, Delay,
Pitch Changer, Highpass, Lowpass, Bandpass and Noise Reducer. Select
an audio track in the Timeline and then select a desired audio effect. Use the
controls available for each effect to hear the change it makes to your audio file. 



As is true with the other Editing operations, when you have found the audio
effect and setting you are happy with, click the Apply button in the Audio FX
pane to apply to the selected clip. 

Chapters Pane
The Chapters pane is also new in iMovie 06. This pane allows you to insert the
chapter markers for iDVD. When chapter markers are added, iDVD will build a
scene selection menu based on where the chapters are placed. 

E D I T I N G  I N  M I C R O S O F T  M O V I E  M A K E R

Microsoft Movie Maker 2 is a video editing application that is included in the
Windows XP operating system. Movie Maker can import media and capture
video as well as arrange images, video and audio on a timeline. It can also add
visual interest and depth to your digital storytelling project with the addition of
video transitions and effects and title and credit slides. 

Microsoft Movie Maker Interface
As is true with any new software, it is good practice to first familiarize yourself
with the interface you will be working with. Movie Maker has an easy-to-under-
stand interface that comprises four main areas: the Task pane, the Collection
pane, the Timeline/Storyboard work area and the Preview Monitor. 

To review the interface, notice the title bar at the topmost edge of the applica-
tion. Until you have a named project, the title bar will say “Windows Movie
Maker.” Once you have a named project in the works, the title bar will show the
name of whichever project you are working on. On the right-hand side of the
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title bar are the standard Windows buttons for Minimize, Maximize and Close.
Below the title bar is the menu bar, which contains pull-down menus for File,
Edit, Tools, Clip, Play and Help. Take a moment to look at each pull-down
menu and see which functions each offers. Below the menu bar is the toolbar,
where icons provide shortcuts for many of the functions found in the pull-down
menus. Roll your cursor over each icon and pause (without clicking). You will
see what the button is used for. The toolbar also contains buttons for viewing
the tasks and collections as well as a drop-down navigation for selecting a col-
lection.

As is true with many software applications, in Movie Maker there are a number
of ways to accomplish a given task, and you should use whichever method you
are most comfortable with.

On the left side of the application, you will find the Task pane, which is where
you can access many of the common tasks for creating your story. If the Task
pane is not visible, click the Task button from the toolbar to activate it. There is

a logical progression to the options
available in the Task pane that will
assist you in making your movie: 1.
Capture Video, 2. Edit Movie, and
3. Finish Movie and Movie
Making Tips. 

The Collections pane is located in
the center of the application and is
where the contents of collections

can be viewed. Click the Collections button to view which collections are avail-
able. This is also where the Video Effects and Video Transition collections can



be accessed. When you click the Video Effects button or the Video Transition
button, the contents of the corresponding collection will appear in the
Collection pane. 

The Preview Monitor is located on the right side of the application and is used
to preview the images, video clips, video effects, transitions and timeline of the
story you are creating. Adjust the size of the Monitor by hovering your cursor
over its left edge until it turns into a two-sided arrow. Then click, hold and drag
the edge to increase or decrease the size of the Monitor. Select any piece of
media you wish to preview in the Monitor, either the Collection pane or from the
Timeline, by clicking it once. Use either the control buttons at the bottom of the
monitor or the Play pull-down menu to start playing your selection, to stop it or
to move it forward or backward. Clicking a selection in the Timeline will play the
timeline from the selected point forward. To view a selection in full-screen
mode, click the Play button, then click the small blue button with a pointed
arrow just above the Play button. Return to the normal view by clicking the
Escape key.

The Timeline/Storyboard work area is located at the bottom of the application.
This is where all of the various media elements will be arranged and edited
together. Depending on which view you want to work in, you can click the
appropriate button to toggle between Show Storyboard and Show Timeline. 

Working in the Storyboard mode allows you to see the order of images as well
as the transitions and special effects that have been added.
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Work in the Timeline view when you wish to work on the timing of the images
in your project. Expand the Video track by clicking the + sign to the right of the
word “Video.” This will allow the Transition track and the Audio track associ-
ated with the Video track to be visible. Use your cursor to manually move the
Play indicator from left to right or press the space bar to begin playing. Click
the Rewind Timeline button to return the Play indicator to the beginning. Use
the Zoom In or Zoom Out tools to view the timeline in larger or smaller time
views. 

The Timeline view has additional tracks where Audio/Music can be added.
This is the track we will use to add voiceover narration to your story and, even-
tually, to add a mixed track of your combined voiceover and sound track.

The Title-overlay track can be used to superimpose titles directly over clips.

Understanding How Time Is Measured in Digital Video
When you begin editing with images and video clips, it is necessary to under-
stand how video is measured in terms of time. Video is measured in a unit of
time called a frame. There are 30 frames of video processed for each second of
video; conversely, each frame of is 1/30 of a second. Video time is read with the
following structure: hours:minutes:seconds:frames. A timecode written as
01:30:12:10 is read as: one hour, 30 minutes, 12 seconds and 10 frames.
Familiarize yourself with this format because it is how all indicators of time are
described in video editing. 

Default Settings
Before beginning a new project, it is a good idea to examine the default settings
that are in place for your movie. To check the settings, open Tools>Options.



Under the General tab you may wish to enter your name as the project default
author. This tab also has a button to Reset All Defaults, near the bottom of the
page. Under the Advanced tab you will see values for Picture Duration and
Transition Duration. Set the Picture Duration to 5 seconds and the Transition
Duration to 2 seconds; they can be adjusted during the editing process if
desired. Next, select the correct Video Format for your country, either NTSC
(for North America) or PAL (for Europe and Asia). Finally select the Aspect
Ratio you desire; for this workshop, we will select a 4:3 ratio. When you have
completed making your default settings, click OK.

Begin a Project
We refer to the product we will create in Movie Maker as a project. A project
contains all of the arranged elements that we have prepared and will import into
Movie Maker for use within the movie. This includes video clips, photos and
images, voiceover, and a sound track. Every edit you make to your project,
whether deletion, addition or change, should be saved, and when the project
file reaches its final form, you will save it as a self-playing movie. 

When you begin a project in Movie Maker, it is important for you understand
that Movie Maker, as a nonlinear editing program, accesses media from a loca-
tion in its directory. Therefore, it is critical to keep your media in the same direc-
tory location throughout the project so Movie Maker can access and display the
media correctly.

Begin a new project by selecting File>New Project. Name your project, then
choose File>Save Project As and save it within your digital storytelling materi-
als folder (see “Preparing Visuals” in Chapter 2). Notice that Movie Maker
assigns the extension .mswmm to the project file. 

Create a Collection
Now we will create a Collection in which all of our digital storytelling materials
will be organized together into one group for easy access in Movie Maker. To
create a new collection, activate the Collection pane. Click the Collection but-
ton in the toolbar to do this. Next, select New Collections from the Tools pull-
down menu; you will see a new collection appear on the left side of the pane.
Name the new collection with a name that will reflect your project and press
Enter. Now we will import the digital storytelling materials into this new collec-
tion.
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From the Movie Tasks pane on the left-hand side, select Import Pictures from
the 1. Capture Video section. Navigate to the appropriate folder that contains
photos for use in your digital story. Select all of the images inside the directory
by clicking the image at the top, holding down the shift key and then clicking
the last image. Click the Import button on the right side of the box. Your final
images will now appear in the Collections area, and you can scroll through
them by using the scroll bar on the right side of the Collection pane. 

Repeat the import process for audio files: Use Import Audio File and navigate
to the appropriate directory, then select your voice-over and click Import. Your
voiceover file will now appear in your collection along with the previously
imported photos. 

If you have previously digitized a video clip, select Import Video from the Task
pane and navigate to the directory that contains the file named Video Clips.
Note: Before selecting your clip and choosing Import, be sure to uncheck the
box labeled Create clips for video files. By unchecking this option, we are
turning off the automatic clip generator. The video clip will now be imported into
a new collection and not into the same collection with the photos and voiceover
files. Follow the directions for moving a clip from a new collection into your
main media collection in the next section. 

Capture Video From Digital Video Camera Using Movie Maker
The first step in having Movie Maker capture video from your digital video cam-
era is to connect your camera to your computer using the correct cable, usually
a Firewire or USB cable. Next, set your camera on Play mode. Then select the
Capture from video device option from the Movie Tasks pane. The Video
Capture Wizard should now appear, with your camera recognized as an avail-
able device.



Select the correct Audio device to transfer the audio along with the video—
most likely the correct option will be Capture audio—using the same USB
cable as the video. You may wish to review the video configuration settings
before proceeding to the next step. To do this, click the Configure… button on
the right side of the box. Click the Video Settings button and review the
options to change Frame rate, Color space and Output size. We recommend
the default output size of 320 x 240, as it is the most efficient resolution size for
digital storytelling projects. Click OK to accept the options. Click Next on the
Video Capture Wizard box to continue.

Enter a file name for your captured video. All video captured during this session
will receive this name followed by a number. Choose a place to save your cap-
tured video—we recommend saving to the folder previously created on C:Drive,
entitled Video Clips. The next dialog box will display the setting details you
have chosen for capturing video; click to move to the next step when you are
happy with the settings. 

With your camera in the Play mode, begin capturing video by clicking the Start
Capture button. Stop the capture when you reach the end of what you wish to
capture (remember to also stop your camera from playing). Click the Finish but-
ton; Movie Maker will generate multiple clips based on scene changes, and the
clips will be added to a new collection. 

For easier editing, we will move these video clips into our main collection with
our other assets, including voiceover and photos. To move the video clips, first
select all of the clips in the newly created video clips collection. Next choose
Cut from the Edit menu. Navigate to and open your main media collection from
the Collection pull-down menu and choose Paste from the Edit menu. The
video clips should now be included in your main media collection. You can
rename these generically numbered video clips now located in your main media
collection with more descriptive titles by right-clicking a clip and choosing
Properties. Rename the clip in the General area of the Properties box. Delete
the now-empty collection by selecting it and pressing delete.

Create a Rough Edit: Adding Voiceover Narration and Images
Using your main media collection, you can now begin arranging the photos and
video to help visually illustrate your digital story. Since your voiceover narration
is the primary focus for the story, we will first place this and build the images
around it. With the work area in the Timeline mode, click the voice-over file,
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located in the main collection, and drag and drop it into the Audio/Music track;
the file should drop easily into place. Click to select the voiceover clip and drag
it to the far left, so it is placed at the beginning of the timeline. Be sure to
expand the clip to its full length in the track. Rewind the Timeline to the begin-
ning and press Play; listen to your voiceover from beginning to end to ensure
the entire clip has been expanded.

Because Movie Maker provides only one track for Audio/Music, we will eventu-
ally need to remix your voiceover file with your sound track file and reimport
into the Timeline. But for now, let’s work to arrange your visuals to your story.

Select a photo and drag it into the Video track of the Timeline. You will see that
the duration of the photo on the Timeline is 5 seconds, as we have previously
set this as the default duration for photos. Because Movie Maker references—
that is, uses instances of your media files—your images and videos, you can
make changes to them within the timeline and not affect the original. To change
the length of time the photo appears on screen, click the photo within the
Timeline and drag the edge of the clip to make it shorter or longer, depending
on your preference. As you increase or decrease the duration of the clip, Movie
Maker will indicate the new duration length.

Add a video clip to the Timeline using the same drag and drop process. You will
see the video clip appear in the Video track and the associated audio will
appear in the Audio track when the Video track is expanded. Since a video clip
is a finite piece of footage, you cannot increase the duration of the clip as in the

case of a still photo, but you can decrease the duration of the clip by clicking it
in the Timeline and dragging either end in; watch the clip in the Preview Monitor
to visualize the exact location of where you want the clip to be trimmed. And
again, because Movie Maker is referencing the video, trimming a clip does not



change the original clip. Keep in mind that the audio associated with the video
will also be trimmed. If you wish to hear the associated audio in your story,
leave the audio as it is. If you do not wish to hear the audio associated with the
video, click the audio portion of the clip in the Audio track and mute the clip by
choosing Mute from the right-click menu.

Remove an unwanted clip from the Timeline by selecting it and pressing Delete
or by right-clicking it and choosing Delete from the right-click menu. Deleting a
clip or photo from the Timeline does not delete it from a collection. Move a clip
from one location on the Timeline to another by clicking it and dragging it to its
new location; a blue vertical bar will appear where your image is relocated.

Create a rough cut of your story by placing all of the desired images and video
into their correct location on the timeline. Preview your work as you progress to
get a feel for the flow of the story. Remember that because Movie Maker uses
references, you are able to use an image or clip multiple times in your Timeline
if you wish. Remember to save your project frequently!

Adding Video Transitions
Once you have a placed your images in the desired order on the Timeline, you
can finesse the flow of the story by adding video transitions. A video transition 

is an effect that is used to move from one clip to the next. Digital storytelling
often uses very simple transitions, such as Fade or Dissolve or even a straight
cut to move from one scene to the next; but video transitions can add visual
interest to a story, such as using a heart transition in a romance story or a page
turn to indicate written correspondence or passage of time. But be careful:
Don’t overuse novelty transitions that can distract from your story. 

Up to now, you have been working in the Collection mode, adding and arrang-
ing your media elements in the Timeline. Let’s switch now to the Task view by
clicking the Task button in the toolbar. In the Edit Movie section, click View
video transitions to view a collection of transitions available.
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You can add transitions to your story in either the Timeline view or the
Storyboard view of the work area. Let’s first look at this process in the
Storyboard view. To add a transition between clips, select a transition from the
Collection pane and drag to place it in between two images. Press the Play but-
ton in the Monitor to preview what the transition looks like. To place a transition
in the Timeline view, click and drag a Transition from the Collection area to the
Transition track; a blue vertical line will appear in the area where a transition can
be placed.

Remember the default duration for a transition has been set to 2 seconds, so if
you like the transition but want to adjust the time duration, you can do this by
selecting the clip in the Transition track and increase or decrease it by adjusting
the duration of the clip.

Tip: To trim a transition in the Transition track, drag from the side of the leading
image. To delete a transition, select the transition in the Timeline view and press
delete. 

Adding Video Effects
By this point in your production, you should have all your images and video
placed and into position to support your narration. You should also have video
transitions in place. We will now supplement the edit by adding video effects
and title graphics. 

Movie Maker provides a collection of video effects that can add visual interest
and enhance your story. From the Task pane, click View video effects to dis-
play the Video Effects Collection. Scroll through the collection to see which
effects are present and which ones might enhance your story. Add video effects
to your project by using either the Timeline view or the Storyboard view. 

When using the Storyboard view, drag an effect directly onto a clip; you will see
a star icon appear in the lower-left corner of the clip. Adding a second effect to
the clip will add a second star. Preview how the video effect(s) look in the
Monitor. To remove a video from a clip in the Storyboard view, right-click the
image to which the effect was added or right-click the effect star. Select Video
Effects from the contextual menu; the Add or Remove Video Effects dialog
box will appear. Select an effect to add or remove and click OK. 

To add a video effect using the Timeline view, drag a selected effect directly
onto a clip in the Video track. Again, a star will appear to indicate an effect is



present. Remove a video effect in the Timeline view in the same manner as in
the Storyboard view.

Adding Titles and Credits
Movie Maker provides several useful options for adding titles and credits to
your digital story. To access these options, click Make titles or credits from
the Edit Movie section of the Task pane. Here you will find options to:

• Add a title to the beginning of the movie
• Add a title before the selected clip in the timeline
• Add a title on the selected clip in the timeline
• Add a title after the selected clip in the timeline
• Add credits at the end of the movie

Click the type of title you would like to add; an Editing box opens. If you have
selected the option for a title to be added before or after a selected clip, you
can now select that desired clip in the Timeline.

Next, enter the title information in the text edit box, then add movement to the
title by clicking Change the Title Animation. Choose an animation you like—
Titles with one line or Titles with two lines. Preview your choice in the
Monitor. An elegant choice for digital storytelling titles is Fade In and Out.

Next click Change the text font and color to make any desired changes to
text font and background colors. When you are happy with the way your title
appears in the Preview Monitor, click Done, add title to movie. 

Notice that the title you have just created now appears in the position you origi-
nally selected, either at the beginning of the movie or before or after a clip
selected in the Timeline. If you chose the option to add a title on the selected
clip, the title will appear in the Title Overlay track of the Timeline in the location
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you have selected. Title clips work like other clips, and their duration can be
increased or decreased by selecting and trimming the clip. To make changes to
a title that has been added to your project, double-click the title in the Timeline,
and the Title Editor box will appear. To delete a title, select the clip and press
the Delete key. 

Add final credits at the end of your digital story to acknowledge the people who
have helped or contributed to your project. Create a credit the same way you
created a title—select Make title or credits from the Edit Movie section of the
Task pane and select the option to Add credits at the end of the movie. The
Editing box appears and is configured in cells to help you add credits. Use the
top cell to enter the name of your digital story. Tab to the next cell and enter
any credit information you wish, such as “Written by:”; tab to the next cell to
enter the name of the writer. Continue adding credits as needed by tabbing
from cell to cell. To change the manner in which the credits will animate on the
screen, select Change the title animation. Scroll through the options available
under Credits and sample any that appeal to you. Next click the Change the
text font and color option to change these items. When you have made the
changes you want, click Done, add title to movie. The credits will now be
added to the Timeline as a clip at the end of your project. 

Adding a Sound Track
As we have previously discussed in this chapter, Movie Maker is limited to one
Audio/Music track. Although a voiceover may be placed into the track and
music added at any vacant spot on the Audio/Music track, it is not possible to
have both the voiceover and sound track play together simultaneously.

If you wish to add a sound track to your digital story, it will be necessary to mix
your voiceover narration and sound track together into one audio file using
Audacity. When this is complete, replace the now married voiceover and sound
track into the Audio/Music track.

Adjust All Elements for Timing
By now, you should have all media elements added into the Timeline, including
a combination voiceover and sound track clip. The next step is to review your
story in the Timeline view from beginning to end, checking that all the individual
elements of media are aligned and timed correctly to your voiceover. Preview



the entire project, making any necessary adjustments, being certain to save
changes as you work. 

Publish Your Story
You should now be finished with your digital story, including the editing. It is
time to save it to a movie format 

Movie Maker provides options to save your digital storytelling project in several
formats. These options are listed in the 3. Finish Movie and Movie Making
Tips section of the Task pane. For the purposes of this workshop, we will
review the steps to Save a movie to my computer. 

In 3. Finish Movie and Movie Making Tips, click Save to my computer. The
Save Movie Wizard dialog box appears, and you will enter a file name for your
saved movie. The name of your project will already appear in the file name area,
but you can change this if you like. The next option is to choose a location to
which you will save your movie; the default location is the My Videos folder in
the My Documents location. Click Next to continue.

In the next page of the Save Movie Wizard, you will see options for the Movie
settings. Because we have previously selected Save to my computer, the wiz-
ard has preselected the Best quality for playback on my computer radio but-
ton. The settings details and file size of your movie are also indicated at the
bottom of the box. Continue by clicking Next; the movie is now being saved,
and the wizard will indicate the progress. The Save Movie Wizard will display a
new screen indicating the movie has been successfully saved. There is an
option here to Play Movie when I click Finish. Click Finish to view your movie. 

If you like, review the other options for saving your project as a movie. Movie
Maker can Save to CD, Send in e-mail, Send to the Web and Send to DV
camera.
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Now that you’ve learned the concept and the tools of editing video using
iMovie or Movie Maker, let’s consider the role audio plays in your digital story.

Audio is a primary component of any digital story. Being able to hear the words
clearly, without static, distortion or interference, is key to engaging your view-
ers. Adding a sound track to a digital story is one of the really fun and easy
parts of creating your piece. Thoughtfully chosen music can add so much tex-
ture and emotion. Knowing how to adjust the volume for best levels is also
essential. If your sound track is too loud, the narration will be drowned out; if it
is too low, it is frustrating and becomes a distraction. 

Now we’ll talk about the various software programs available for recording
audio and provide information on how to add a sound track to your piece. We’ll
also offer direction on how to adjust the sound levels, effects and narration. 

A U D I O  E D I T I N G  S O F T W A R E  O P T I O N S  A N D  R E C O M M E N D AT I O N S
Whether you want to add audio or create audio for your digital story—or both—
may influence your choice of software.

GarageBand
GarageBand is part of the iLife Suite of tools and has particular appeal for peo-
ple with an interest in creating their own compositions. Using an original piece
of music is desirable because it adds even more of your creativity and person-
ality to the story and avoids any possible copyright issues. We generally do not
recommend using GarageBand during the DSI workshop unless you have previ-
ous experience generating original music. Teaching the mechanics of
GarageBand as part of the digital storytelling process is outside the scope of
the class, therefore we recommend working with GarageBand outside class and
bringing your completed music piece.

Editing Audio



55Sound Studio
If you are working on a Mac to create a digital story, you may choose to use
Sound Studio to record and edit your voiceover narration. Sound Studio is a
shareware application that interfaces well with iMovie. The controls are easy to
use and the software offers a viable waveform graphic that enables you to visu-
alize the volume of your narration. While allowing for volume variations that are
inherent to the story—for example, the voices of others—we recommend keep-
ing the waveform of your narration relatively consistent throughout the piece. 

Sound Studio allows you to create a new file and record all of your narration in
consecutive segments. It lets you build your entire narration in one file, which
can then be easily imported by iMovie. We recommend using Sound Studio for
its ability to easily edit your audio narration, its waveform feature and its seam-
less integration with iMovie. 

Audacity
Audacity is another free, easy-to-use cross-platform sound editor that allows
you to record, edit and export your voice-over narration. Although Audacity
works with both Mac and PC, we especially recommend this software if you are
creating your piece using Microsoft Movie Maker on a PC. Audacity can work
with imported .wav and MP3 files, but it cannot work with .wma files, so plan
your media accordingly. If you are working with Movie Maker, you may quickly
realize the limitations of not having a dedicated audio track for the voiceover
narration and a separate dedicated audio track for the sound track; use
Audacity to mix these two separate tracks together into one file for use in
Movie Maker. 



iMovie
Yet another option for recording an audio narration when working on the Mac is
to record directly into iMovie, which has a simple interface for this task.

Click the Media pane button to activate the Audio/Photos tab options. Click
the Audio tab to activate the Audio pane. Notice the area at the bottom of the
pane is labeled Microphone. Fortunately, most late-model Mac computers
have a built-in microphone so you can speak directly into the computer to
record. If you wish to use a different microphone, simply plug it into the stan-
dard microphone jack. If you’re using an external USB microphone, plug it into
a USB port. 

Confirm that the microphone is working by speaking a few words and watching
the green meter levels rise and fall with the sound of your voice. If you have
chosen to use an external microphone device, you may need to select a differ-
ent sound input source from the System Preference>Sound>Input options in
order for the microphone to input the sound into the program.

To begin recording, press the red radio button on the right side of the
Microphone levels bar. If desired, you can move an image or video clip into the
Timeline to give you visual cues for your narration. (If you use a video clip, be
sure to mute any audio on the track.) The audio recording will begin in the audio
track where the Playhead is parked. To stop recording, press the red record
button again. Notice that iMovie will drop the recorded track into available
space on one of the two audio tracks. To hear the clip, move the Playhead at
the beginning of the clip and press the Play button. To move the clip from one
track to another, simply select and drag. If you are not happy with the narration
you recorded, simply select it and delete the track from the Timeline.

Keep in mind you can record small sections of a narration at a time, then
arrange them in the proper order in the Audio track of the Timeline. iMovie will
number the audio clips in order as they are recorded; however, to keep your
audio recordings organized, you may wish to double-click the recorded piece
and rename the clip in the dialog box. 
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Although the ability to record narration in iMovie may be adequate for some
purposes, it may not provide the control necessary for consistent recording
results. iMovie allows you to view the audio waveform (a graphical representa-
tion of sound) by checking this option under the View pull-down menu. iMovie
will not allow you to view both the waveform and the name/number of the clip
at the same time, but hovering your cursor over the track without clicking will
provide the identity of the clip. We stress the importance of having a consistent-
looking waveform through the duration of the narration; for this reason, we rec-
ommend using one of the previously discussed audio editors (Sound Studio or
Audacity) for finer control.

Adding a (Non-iTunes) Sound Track to iMovie
Earlier in this chapter we discussed how to add a music track to your movie
using the Audio pane and selecting a track from your iTunes library. That is one
way to add a music track, but what if you don’t have an iTunes library? Like
many applications, iMovie offers multiple ways to achieve the same result. In
this case, we’ll talk about how to add a music track to your story from a CD. 

First insert the CD into the CD drive of the Mac. The CD appears on your desk-
top and iTunes launches automatically. If you don’t know which track you want
to select, use iTunes to listen to the tracks and make your decision. When you
have determined which cut to use in your story, import it into iMovie. 

To import a track into iMovie, first activate iMovie and choose File>Import.
Navigate to the CD located on the desktop. Choose the desired track by dou-
ble-clicking its name. iMovie will import the track. (Follow the progress by
watching the progress bar.) By default, iMovie will place the beginning of the
music track where the Playhead is positioned. Once the track has been import-
ed, you can easily move it forward or backward to align with the beginning of
your movie. 

Mixing and Adjusting Levels
iMovie works with two audio tracks; however, iMovie is cable of layering up to
99 effects of music per track. The challenge is to adjust the volume levels of
each effect, the music and the narration so that all of the elements can be
heard in correct balance. 



To adjust the volume levels, check the Show Clip Volume Levels option under
the View pull-down menu. You will then see a purple rubber-band style volume
control in each audio track that is present, including sound effects. Click any
point of the purple control line to create an adjustment point. The point will turn
yellow and permit you to raise it (increase volume) or lower it (lower volume)
within the track, so just continue to raise and lower the point until you are satis-
fied with the volume settings. 

On the right side of the Timeline are three Audio shy-track check boxes. When
you check a box, the corresponding audio track is muted and you don’t hear it.
This feature can be very useful if you would like to work on the volume settings
of the sound track and the sound effects without hearing the narration, and
vice-versa. 

Adjust the levels so that when all sound is played together, the volume is cor-
rectly balanced among the narration, sound track and sound effects. Voice nar-
ration should have priority; the sound track should be set lower, with sound
effects balanced according to the time and duration of the intended impact. 

Editing audio is really fun and you can spend a lot of time adjusting many
nuances. Learn to hear what is playing and don’t be afraid to experiment with
different volume settings in order to detect the differences they can make in the
way the story is heard. 

T H E  D S I - R E C O M M E N D E D  W O R K F L O W
1. Place voiceover narration in an audio track.
2. Begin ordering images into Timeline. 
3. Create titles and place into correct position on Timeline.
4. Add Transitions between clips, titles and credits.
5. Add Ken Burns Effect on still photographs.
6. Add a sound track.
7. Add Video FX.
8. Add sound effects.
9. Adjust volume levels of narration, sound track and sound effects.
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If you have owned or used a computer during the past decade or so, chances
are you have had occasion to view movies or video on it that was created by
another computer. This may include a CD-ROM or DVD with built-in movies as
part of the content, on the Internet, where video is frequently included as part
of Websites, as video podcasts (vodcasts), and via e-mail.

Multimedia productions—video, animation and music created by a computer—
must undergo a specific type of processing to be played back or viewed on a
computer other than the one it was created on without the original software
being present. Because file sizes of video pieces are very large, it is not 
practical to transfer and play them back at their original size on other 
computers. For this reason, movies must be compressed to a size capable 
of being moved easily from computer to computer. Once reduced in size 
(compressed), they can be copied and shared on a CD-ROM or DVD storage
medium or via bandwidth on the Internet. Because the computer world is so
complex and diverse, there are a number of file formats that video may be
played back or viewed in. This section will briefly examine a few of the most
commonly used digital video playback file formats.

Q U I C K T I M E  ( . M O V )
QuickTime is an architecture developed by Apple Computer. Multimedia
processed using QuickTime add the extension .mov as an indicator that 
the file is a QuickTime file. QuickTime is the standard file format for Macintosh
computers both for output (processing) and playback. To view QuickTime
movies on a Windows machine, download the appropriate player from
Apple.com/quicktime.

Because you have just created a digital story using iMovie, we will complete
the production process using QuickTime so you and others may view your
movie without iMovie software.

R E A L P L AY E R
Developed by Real Networks, RealPlayer is a software application or plug-in
that provides playback for compressed multimedia productions. RealPlayer,
compatible with both Windows and Macintosh platforms, will play media files
located on your computer as well as on the Internet. 

W I N D O W S  M E D I A  P L AY E R
Windows Media Player is Microsoft’s proprietary software for 
multimedia playback using PCs.

File Formats



61It is a traditional practice to share your piece with others in the workshop. 
In this section, we will discuss the steps of how to export your movie so it 
can be shared with others.

W H AT  D O E S  E X P O R T  M E A N ?
Cook, Make, Crunch are all casual terms multimedia producers use when they
talk about exporting a movie. When we say “make a movie,” “crunch a movie”
or even “export a movie,” we mean the process of rendering the production
from the project state (the state you have been working in) to the compressed,
stand-alone state where playback is possible without use of the software used
to create the piece—in our case, without iMovie.

Before you export your story, it is good 
practice to do a final Save to update your
project file. Next, choose Share tab in the
main menu. The dialogue box that appears
will provide a number of options for how your
finished movie can be used. Select a use for
your movie from the choices of Email,
HomePage, Videocamera, iDVD, QuickTime
or Bluetooth. For this workshop, we will
export, or Share, using QuickTime. Select the QuickTime icon 
from the top of the dialogue box.

A secondary dialogue box will appear with
prompts for exporting your movie to
QuickTime. In the center of the window is a
pull-down menu with the QuickTime pre-set
compression settings. Compress Movie For:
Email, Web, Web Streaming, CD-ROM, Full
Quality DV and Expert Settings. Since we
want to be able to watch our movie from the
computer, select Full Quality DV. 

A message will appear in the dialogue box with specific details of how your
movie will be processed. You will probably agree with these details so press
Share. iMovie will then ask you to name the movie and choose a location to
save it in. Your movie will begin to render and may take a few minutes or
longer depending on the size of your project file. When the movie has finished
rendering, you can view it by double clicking on the file and using the 
Player controls.

Export the Finished Story for Other Uses



PUBLISHING AND DISTRIBUTING YOUR STORY 

iMovie’s Share function provides very useful pre-set output choices
for your digital story. Output specifications should be considered
for whatever your intended distribution use or sharing purpose may
be. There are many  places to distrbute your stories: YouTube,
Facebook, and My Space to name a few. When you upload digital
media to a server, you should try to keep the file size small for
quick download.

Output specifications you should consider are:

Frame Rate
Full-frame video runs at a rate of 30 frames per second. Anything
less than this will have some visible “loss.” 

Screen Size
Full-frame (full-size) digital video is sized at 720 pixels (horizontal) 
by 520 pixels (vertical). Half-size video is sized at 320 x 240 pixels, 
quarter size at 160 x 120 pixels.

Sound
Sound can be in full two-channel stereo or mono.  

File Size
One of the most important considerations is file size. The file size
correlates with the frame rate and screen size—the lower the frame
rate and smaller the screen size, the smaller the file size will be.
Moving large-size files across the Internet is only possible for peo-
ple with very large and fast connections, so a smaller file is prefer-
able for uses such as e-mail and Websites. Other storage media
like CD-ROMs or DVDs can handle larger file sizes. CDs can hold 
approximately 700 MB of data and DVDs can hold approximately 
4.3 GB of data.

iMovie offers pre-set compression settings for the following
uses: 

E-mail
Use this option to process your movie small enough to e-mail to
friends, family or business contacts. E-mailed movies are com-
pressed at 10 frames per second, screen sized at 160 x 120 (pixels)
and have mono sound. 



HomePage
This option renders your movie for use on the Web. Your movie will be 
compressed to 12 frames per second, screen size of 240 x 180 (pixels) 
with mid-quality stereo sound. File size will be estimated.

Videocamera
This is a very useful and highly recommended option for archiving your story.
We suggest archiving your completed movie to good-quality videotape. Be sure
to label your tape and, following the transfer, flip the safety switch on the side
of the tape to avoid recording anything else over your story.

iDVD
A discussion of iDVD requires an entire manual on its own, thus is beyond the
scope of this workshop. Among other wondrous capabilities, iMovie integrates
seamlessly with iDVD to add chapter markers within your movie. 

Quicktime
QuickTime compresses video for various uses. We’ve already mentioned the
settings for Email and HomePage. In addition, QT will process video for
streaming Web (to play live from the Internet) at 12 frames per second, 
240 x 180 pixels and mid-quality stereo sound. File size will be estimated.

QT compresses video for playback on CD-ROM at 15 frames per second,
screen size of 320 x 240 pixels and full-quality stereo sound. Choosing to
process your movie in Full Quality DV creates a single DV movie file with no
loss of quality. Your movie will play full-size: 720 x 540 pixels, 30 frames per
second with no loss of compression. These files will be larger in size than 
compressed files.

iPod
The iPod export setting formats your story for the iPod. It is sent directly to
iTunes, placed in your iTunes library, and then you’re able to copy it to your
iPod. 

E X P E R T  S E T T I N G S
Expert settings allow you to choose your own compression rates. The exported
size will depend on which options you select. If you wish to experiment with
Expert Settings, we recommend independently researching the various codec
(compression/decompression) options available.
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A R C H I V I N G  S U G G E S T I O N S
If you are not using your own computer to create your digital story, you probably
would like to save all of your digital materials to work on again at another time, 
or even reuse some of the materials you created for this story in a different story.

We highly recommend archiving all your digital media, including working 
assets, iMovie project file and your completed movie. Because digital video 
uses tremendous amounts of hard-drive space (remember, five minutes of digital
video takes up 1 GB of hard-drive space), all of your material combined is likely 
to take up a large amount of space. One suggestion for archiving your material 
is to invest in a FireWire hard drive. FireWire drives, for large amounts of storage
space, are easy to connect to the computer and are becoming increasingly 
more affordable.

Another option is to archive your material to other forms of storage media, 
including DVD and CD-ROM. DVDs can hold approximately 4.3 GB of data 
and CDs hold approximately 700 MB of data. Try to assess the amount of 
material you will need to archive before deciding which storage device may 
work best for you.

We suggest archiving:

Digital Media Assets
Original photograph and artwork scans, images that have been enhanced 
using Photoshop, voiceover narration files, iMovie project files and completed 
.mov files.

If you have original video footage recorded on a recent format of tape, you can
save space on a hard drive or other storage device by not archiving video clips 
digitized for use in your project. Digitizing video is a very easy procedure using
iMovie, and we suggest digitizing video on an as-needed basis. content—archive it
to another format immediately. 



65Sharing your digital story with friends and family is an essential part of the 
digital storytelling process. Digital stories can offer insight and knowledge 
that others may otherwise not know. Digital stories can preserve part of your
essence so future generations may one day learn something about you—
something you cared about and thought was important.

Communicating a message through story is a powerful resource; distributing 
stories to larger audiences can educate, encourage thought and initiate change.
Digital stories offer people a chance to respond to world events or personal 
experiences, to process the event, interpret its significance to themselves and 
offer insight about how change is necessary.

Consider a cause you care about or a life-altering experience. Then realize how 
stories told about this subject may compel others to become involved, make 
a difference, effect a change.  

Storytelling can be used as a resource for change, community and peace-
building efforts, personal reflection and affirmation. Stories can be used as 
an archive or reference for historical events.  

Integrate digital storytelling into your organizations’ outreach efforts, self-publish 
and distribute stories via Websites or author your own CD or DVD. Submit your
story to film and video festivals for exposure. Include your story in relevant 
presentations or speeches and screen it at meetings and gatherings. New 
media and independent publishing have enabled innovative and effective 
avenues through which to get your message heard!

Using Digital Storytelling as a Resource for Change





Storyboarding Template
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